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 Chapter 4.

Forms and Browses

Its a visual thing…

Forms and browses are all about inputting data and viewing records. Alpha Five
has always made it easy to design sophisticated styles for the desktop. Now, you can
plan for the future with systems that can be used on both desktop and web. Best of
all, the built-in design aides make everyone look like a pro!



CHAPTER 4. FORMS AND BROWSES
Overview

70

Overview

We cover a LOT in this chapter. Since it so lengthy, we’ve broken it down into sections. Here’s a quick review of the
topics and where you’ll find them when you need a refresher for your own application. Exercises are created in “teaching
order,” so look in around for what you need. Details in the Table of Contents and Index.

Topic Page

Part 1. The basics of form design

     ‘Understanding Form Design’: Default & Custom Forms, Menus and Toolbars. 71

     ‘Understanding the Task Panes’: Toolbox, DragDrop List, Restoring to a prior version. 90

‘Understanding the Properties Pane & Object Properties Dialog’ 103

Part 2. Tabbed forms

     ‘Creating a Form with Tabs’: Form title, Creating and modifying tab panes. 108

Part 3. Embedded browses

     ‘Understanding Browses’: Difference between stand-alone and embedded browses. 115

     ‘Creating an Embedded Browse’: Create and customize embedded browses, Order records (for form), 
Read Only, Sorting, Undo & Redo commands.

116

Part 4. Placing fields and navigating records

     ‘Placing One–to–One fields’: Place and adjust fields, Ungroup, Copy attributes. 125

     ‘Adding a Record Navigator’: Move tab pane objects, Navigator control. 132

     ‘Placing One-to-Many fields’: How to put them in a form. 134

Part 5. Learning about dynamic objects and form level rules 

     ‘Adding Dynamic References’: Dynamic form title and reference fields, read only. 136

     ‘Creating Form Level Field Rules’: Differences between rules & properties, form level rules. 139

Part 6. Learning the Expression Builder

     ‘Understanding the Expression Builder’: Tour, Functions, Library, Toolbar, Enter Expressions. 145

     ‘Creating Calculated Fields’: Character, Alltrim, Numeric, Combine field types, Edit. 155

Part 7. Using more features

     ‘Refining the Tabbed Form’: Rich Text, Tab Order, Title bar. 162

     ‘More Tips and Tricks for Forms’: Finding and filtering records, Smart Fields, Lock header & footer.

‘Getting Ready for the Web’: Display the data in a grid component on a desktop form. 171

Part 8: Using a web ready form

     ‘Getting Ready for the Web’: Place a web component on a form. 171

Part 9: Stand-alone Browses

     ‘Understanding Stand-Alone Browses’: Design elements, Conditional color, Vertical slider. 176

     ‘Putting a Button, a Smart Field and an Ellipsis in a Browse’: Toolbox > Browse controls. 185

     ‘Using the Ad Hoc browse’ 188

Don’t miss out!

This chapter has several features that are detailed in Alpha Five Made Easy Check them out on page 191.

Image on reverse: Copyright vlad_star, 2012 used under license from Shutterstock.com.
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Preparation for the Lesson.
Open Alpha Five and navigate to the following file:

•c:\A5_MadeEasyDesktopBook\ABC_DesktopLessons\ABC Seminars.adb*

•  Click on the Control Panel tab in the Window Bar at the bot-
tom of the screen to bring the Control Panel to the front.

SPECIAL NOTES Summary Genie: As fields are added to the form, the Summary Genie may pop-up.
Accept the default settings and click Finish. The genie may be deactivated by clicking
the “magic lamp” in the upper right corner of the toolbox.

Sections: Because this is a long chapter, it has been broken into a series of related
exercises. The parts are noted at the left.

Understanding Form Design

PLEASE TAKE A MOMENT TO 
READ THIS

Forms are used for entering, changing and viewing data.

Choosing the right style
Web or desktop form – which is the right style for you? There are two buttons on the

ABC Seminars menu that will give you an idea of how these forms work. 
The first is one of many types of “standard” desktop forms. It has many attractive

features and was created on the desktop side of Alpha Five. This chapter will give

instructions on how to set it up. (Desktop forms cannot be used on the web.†)
The second is a form that can be used on both desktop and web. It, too, can have

many styles – they get more sophisticated with every Alpha Five release – but is created
on the “web side” of Alpha Five. This is a sample only because it is beyond the scope of

this book to teach this type of form.‡

1. At the ABC Seminars main menu, click the Clients button to see one of
the standard desktop forms that we will create in this chapter.

2. Click the Web on the Desktop button to see a sample of a web style
form.

The primary consideration is whether or not you plan to put your database on the
web and, if so, when. If you are wondering if your desktop application can have both
styles, the answer is a resounding “yes!”

STANDARD DESKTOP 
FORMS

If a web database is not in your near future, then the standard Alpha Five forms are
for you. They are easy to create and will have you on the way to a sophisticated desktop

*. Depending on how Alpha Five is opened, the file extension .adb may not appear. (For instructions on opening an existing database, 
see “Opening an Existing Database” on page 14.)

†. Find out why at “Why can’t I use my desktop forms on the web?” on page 172.

‡. To learn about “web components,” the signature feature of Alpha Five for the web, see Alpha Five Web Applications Made Easy by 
Susan Bush. Available at www.libertymanuals.com.



CHAPTER 4. FORMS AND BROWSES
Understanding Form Design

72

application in no time. Their primary purpose is for data entry. They may be printed, but
reports are better for that (see Chapter 5).

There are three types of forms, two of which, Default and Custom are created by the
Genie. The third, Blank Form, is ready for your personal design. Of course, any form
can be modified to suit your needs; these are just starting points.

•Blank Forms begin as a blank sheet of electronic paper.

•Default Forms contain every field in the table or set. These are the quickest 
to make, but often contain more fields than are useful for data entry. Still OK 
if you need most of the fields because the unwanted ones can be removed.

•Custom Forms can be more useful because they can be limited to the spe-
cific fields needed for the form.

Objects (fields, labels, buttons, etc.) are placed on the forms, much the same way
that a lamp, magazine and remote control are placed on a table.

In this exercise, we will briefly demonstrate the process for creating a Default Form.
We will then create a simple, basic Custom Form. At that time we will illustrate how
fields are placed on the form and examine the components of Form Design.

Once you know all the basic elements – and there are MANY! – we will create a new
form from scratch so we can give the user all the Windows bells and whistles, including
tabbed interfaces and embedded browses.

WEB FORMS ON THE 
DESKTOP

If you have been following Alpha Five news, you have been hearing about how web
components can be used on the desktop. For the uninitiated, this is the type of form that
is used for Alpha Five web based databases. If you are thinking about putting your data-
base on the web soon, you may want to consider this style for the desktop, too, because

“standard” desktop forms cannot be used on the web.*

Teaching all there is to know about web component design is beyond the scope of
this book, but if you are at all interested, get started with “Getting Ready for the Web”
on page 171. And then run right out and buy our book, Alpha Five Web Applications

Made Easy to learn how to design more of them!† At this writing, the following web
components can be used on the desktop:

•Grid Component:

•Dialog Component: Compares to Xdialog for the desktop.‡

•Tabbed UI (User Interface) Component: Same idea as the Tabbed Form dis-
cussed on page 108.

•Page Layout Component: Organizes everything into a main menu.

•Google Maps, Video Player and Chart components.

Creating a Default Form
The default form contains all the fields in the table or set. This is the most basic type

of form and is designed completely by the genie, making it very simple to create. We
will also look at the Alpha Five Stylesheets feature.

1. At the Alpha Five Control Panel Tab, click the Forms tab.

*. See “Getting Ready for the Web” on page 171.

†. Go to www.libertymanuals.com for more information.

‡. Xdialog is the Alpha Five way to create custom dialog boxes. (See also page 191.)
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2. Click New button.

3. Data Source: Choose Clients_form (set). (Click Next)

•Sets are identified by a three-box graphic at the left of the listing.

•A single box means it is a table.

4. Choose Default Form (contains all of the fields in the Table/Set.)
(Click Next)

5. Stylesheet: Choose Subtle Glass.

•Stylesheets will help your designs maintain a consistent appearance. There 
are several pre-designed stylesheets. Custom stylesheets can also be created.

6. Click Next and then Finish.

•The Form Editor opens to a three page tabbed interface. The first 
page contains all of the fields in the one-to-one links in the set.

•The second and third pages contain the one-to-many links in the set. 

These appear as Embedded Browses (red box below).*

7. Click the Page 2 tab to see the Browse.

 Previous to Version 9, you had to press the tab twice in Design Mode. Tabbed
forms created in earlier versions may still require the tab to be clicked twice.

Like all forms, the Default Form may be edited. The positions of the fields can be
changed and fields can be removed. 

DESIGN TO FORM AND 
BACK

While designing, you will move back and forth between Design Mode and Form
View.

8.  Click the button at the left of the top row of buttons (Form View) to see
how the form will look to the end user, as well as the results of the Stylesheet
selection.

9.  Click the top left again. (The graphic has changed and now
the bubble help says Design Mode.)

*. Embedded browses will be discussed in this chapter. (See “Creating an Embedded Browse” on page 116.)
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STYLESHEET GALLERY Now that we are back at Design Mode, we will take a quick look at Stylesheets. (See
also page 191.)

10. Click on a field to select it.

11. Choose Stylesheets > Apply or Create a Stylesheet from the top
menu.

•The Style Sheet Gallery 
appears.

12. Click on Green.

•The checkbox at the bottom 
will reveal “Legacy 
Stylesheets.” These were cre-
ated in earlier versions of Alpha 
Five. Feel free to choose one if 
it appeals to you. 

13. Click Apply.

•Inset. You are asked if you 
want to apply to the entire form 
or to the object you selected in 
step 10.

14. Click Entire Form.

15. Click Close.*

16. Click the tabs to see the color changes.

17.  Click Form View to see the new appearance with data.

18. Repeat above to experiment with some other styles, if you like.

19. Click X in the upper right corner at either Form View or Design Mode
to close the form. Answer the next dialogs as follows:

•Form View: Click Cancel at the “Save Form As” dialog box.

•Design Mode: Click No at the “Save changes to current form” dialog.

Creating a Custom Form
Next, we will create a form that contains specific fields. We will also examine the

form design tools. There are a LOT of tools, so take care of your personal needs, grab a
cup of coffee or tea and get comfortable. True, some of this may be boring, but you
really don’t want to miss all the great features – do you?

Ok - maybe you’ll need a box of chocolates to take you to page 108 – and make sure
it’s not too late – can’t have you falling asleep, now.

20. Alpha Five Control Panel Forms tab: Click the New button.

21. Data Source: Choose Clients_form (set). (Click Next)

22. Choose Custom Form (contains fields that you select). (Click Next)

*. If the Confirm form may not come up, close the Stylesheet editor, select a field on the form and re-open. Re-click Apply.
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For this type of field selection dialog, highlight the first
item and double click. Make the second selection, click the
RIGHT ARROW button (red circle) repeatedly to enter choices
into the Fields on Form window. (In this case, click the button 5
times.)

23. Select the following fields.

•Client ID, Enter Date, First Name, Middle Initial, Last 
Name, Company.

24. Click Next.

25. Stylesheet: Alpha Five Default (or any other you
choose). (Click Next.)

26. Click Show Xbasic to open The Xbasic Form Genie.

XBASIC CODE
No doubt, some of you are licking your chops, anxious
to get your teeth into writing code. Others have faces
that pale at the mention of it. To the first, I say “Be
Patient,” and to the second “Don’t panic!” Alpha Five
has been designed with both of you in mind. It can be
used with or without the more advanced development
vehicles. At this time, we will only look at the code.

 NOTE

In most cases, Alpha Five will show you the code that it
writes behind the screens. It is a good way to learn Xba-

sic and the code can be cut and pasted from one script to another.

27. Close the Genie by clicking the X in the upper right corner.

28. Click Finish.

•The form opens with only the 
fields that we indicated.

THE DESIGN TOOLS
The Toolbox and DragDrop List
are at the right (orange arrow). If
you do not see them on your
screen, click their buttons on the
Forms Toolbar (gold pointer).
See “Using the Toolbox” on
page 93 and “Using the DragDrop
List” on page 98.

•The Top Menu is the row of text 
options at the top of the window. 
See “Understanding the Top 
Menu” on page 76.
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•The Forms Toolbar is the row of buttons below the Top Menu. See “Under-
standing the Forms Toolbar” on page 80.

•The Properties Dock Panel is at the left of the screen (green oval). If you do not see 
it, choose Top Menu > Task List > Properties. see “Using the Properties Pane” on 
page 104. We will also use:

•The Right Click Menu. See “Using the Right Click Menu” on page 87.

29. Hover your cursor over the Company field.

•Bubble help gives you information on the field.

30. Click the Company field to give it focus – black boxes surround the
field.

•The Properties Dock Panel (aka Properties Pane) changes to show the avail-
able selections for the field.

31. Right click on the field to see the Right Click Menu.*

• Next, we will examine all the design tools in detail.

Understanding the Top Menu

PLEASE TAKE A MOMENT TO 
READ THIS

As in most Windows programs, many of the sub-menu items are duplicated else-
where; we will define only those that are unique. Open the menus as you read along to
become familiar with the extensive features.

• File and Edit menus contain typical Windows items and their Keyboard Shortcuts.

• View

•Trace Window. Alpha Five reports errors here. (See “Understanding the 
Trace Window” on page 396.)

•Script Recorder Window. Scripts are custom actions that you can create for 
your application. This handy tool will allow you to create scripts by record-
ing your selections. 

•Code Editor. Allows you to create and edit scripts.

•OLE Automation Browser: Allows you to investigate the properties, meth-
ods, events and constants of ActiveX controls on your computer. 
(Advanced)

•HTML Editor. Allows you to create web pages.

•Debugger. A tool for proofing scripts. I told you Xbasic guys you’d have 
something to do soon. Watch all the videos below – after you finish here!

GO TO A5 HELP To learn about the Debugger, go to:

• Help > What’s New > What’s New in V10 > Debugger Features.

•Help > Videos > Xbasic Debugger. Four videos.

*. (See also “Using the Right Click Menu” on page 87.)
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•Status Bar. Information bar at the bottom of the screen. Toggles Show / No 
Show. We recommend keeping the Status Bar active.

•Window Bar. Buttons at the bottom of the screen that access the Control 
Panel and other open windows. Toggles Show / No Show.

•Settings. Global preferences for the database.

•The next seven items are duplicated by buttons. See “Understanding the 
Forms Toolbar” on page 80.

•Object bubble help can be turned on or off. It appears when you hover the 
cursor over an object (field, label, etc.) on the form or the DragDrop List. 

PAY ATTENTION 
HERE!

•This baby will save 
you a gazillion trips to 
the Set Editor.

•Structure Informa-
tion shows the tables in 
the set and their rela-
tionship.The double bar 
arrow indicates one-to-
many. The single bar 
arrow means the rela-
tionship is one-to-one.

a. Click to open.

b. Choose a Table from 
the left pane.

c. Click on the Fields 
tab in the right pane.

•The fields in the table are listed with their type and size.

d. Note the Set Link info at the lower left.

e. Click the A-Z button at the lower left. The fields are shown in alpha-
betical order, helpful for a large table.

f. Click on the Indexes tab to see those created for each table. (See 
“Understanding Indexes” on page 370.)

g. Click on the Statistics tab to see how many records exist and other 
information about the table.

h. Click CLOSE.

32. Click VIEW on the Top Menu to reopen the list.
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•Object Explorer gives relative and explicit 
names for all properties of all objects on the 
form.

XBASIC AID
A primary use for the Object Explorer is to
quickly find the name of objects and properties
for use in Xbasic scripts. This is especially useful
in a form with many fields. 

a. Choose Object Explorer.

b. Object Name: Click on first_name_lbl (label).

c. Property: Drill down* a couple of categories to 
see the properties that can be changed in both 
Design and Form Views. 

d. Changes are made by choosing from the lower 
window and clicking Set.

•To find names of objects: See buttons at the 
bottom of the dialog (inset):

•Copy to Clipboard: Click to see the relative 
and explicit names of an object and its 
selected property. 

•Recorder: Opens the Xbasic Recorder 
where code can be written, copied to the 
clipboard and pasted into the script.

e. Click Close.

33. Go to Form View.

ROLL- UPS Certain windows can be rolled up so they can remain handy, yet are out of the way.

f. Click Roll-Up (under drop down menu above - see inset).

g. Click Expand Object Explorer.

h. Click CLOSE.

34. Reopen the View menu listing to continue.

•Code Explorer lists the Events (see below) that have been designed for the 
form. Code may be edited.

The discussion of the View menu is now complete and we will continue with the
other Top Menu items.

• Task List
These are the tools used in form design. We have already seen the Toolbox, Drag-

Drop List and Properties panes in the illustration on page 75.

•Toolbox and DragDrop List are duplicated on the Forms Toolbar (see 
“Using the Task Panes” on page 91 and “Using the DragDrop List” on 
page 98.).

*. Drill down means to click on the + sign next to the menu item to open the next set of selections.
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•Interactive (Xbasic Aid) opens a window at the lower right where a line of 
code may be tested. See “Using the Interactive Window” on page 102.

•Browse Controls: Allow you to insert buttons and images in both Embedded 
and Stand Alone Browses. (See “Using Browse Controls” on page 101.)

•Properties: Opens the Properties Pane aka Properties Dock Panel.

•Restore Default Layout opens the DragDrop List and Toolbox at the right 
side of the screen, one above the other and places a tab for the Properties 
Pane at the top left of the screen.

• Form

•Form View is the same as the left button on the Toolbar.

•Form Properties contains settings for the form.

•Events are actions that can be set for the form using Action Scripting or Xba-
sic. Also has a button on the toolbar.

•Grid: The Grid appears on the background of the form in Design Mode. It’s 
purpose is to aid alignment of the objects (fields, labels, etc.) as they are 
placed on the form.

a. Click Grid to open.

b. Grid Spacing: The default is 10 dot markers per 
inch.

•Grid Spacing affects the distance between fields as 
they are dragged onto the form. To have the fields 
touching, accept the default of 10. To space them fur-

ther apart, increase the dot markers a larger grid.*

c. Snap to Grid means that objects move to the grid 
when they are near it, facilitating alignment. Snap may 
be turned off.

d. Show Grid: You may elect to show or not show the grid.

e. Change the Grid Spacing to 15.

f. Click OK to see the change in the grid, then reopen the Form menu.

g. Reset the spacing so that objects are touching (10 dot markers per 
inch) because we will use that setting for our exercises. (Click OK)

•Dynamic Guidelines: Aids for lining up objects on the form. Toggles on/off. 
We recommend you keep them on. (See “Using Dynamic Guidelines” on 
page 86.)

•Calculated fields and Variables: (See Toolbar below.)

• Object

•New covers the same tasks as the Toolbox.

•Properties: (see Toolbar, Right Click Menu and Hot Keys below.)

•Events (see Toolbar, Right Click Menu and Hot Keys below.)

•Pop-up Event Editor (see Toolbar below).

•Size-to-Fit (see Right Click Menu below and Arrange Toolbar.)

*. See step 3 on page 126.
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• Arrange

•Most of these items are on the Arrange Toolbar.

•Set Tab Order sets the order of movement from field to field by the TAB 
key. 

By Example (see Toolbar below)

By Table: Fields are listed and may be moved up or down.

• Stylesheets

•Consistent colors and fonts make an application more pleasing to the end 
user. 

•See “Stylesheet Gallery” on page 73.

•See also“Using the Right Click Menu” on page 87 for additional Stylesheet 
aids.

• Window:

•Cascade, Tile Horizontally, Tile Vertically, Arrange Icons are typical Win-
dows choices.

•Open Windows: Items after the thin gray line are open Alpha Five windows. 

The form with focus* (ClientInfo in example at left) is bolded. Tabs at the 
bottom of the screen also show open windows.

Understanding the Forms Toolbar
In addition to some common Windows buttons, the Toolbar contains the most com-

monly used form design buttons.

35. Hover your mouse over the top row of buttons to become familiar with
their descriptions (some abbreviated below) and shortcut keys.

Reading left to right, the first set of buttons activate:

a. Button 1: Form View. 

HINT! As we indicated earlier, you will switch back and forth between Design and Form
modes while testing the design. While you are not required to save design edits when
testing in Form Mode, we recommend that you become a Frequent Saver.

b. Buttons 2, 3, 4: New Layout (CTRL+N), Open layout (CTRL+O), 
Save Layout (CTRL+S).

c. Buttons 5, 6, 7: Print, Print Preview, Print Setup.

d. Buttons 8, 9, 10, 11: Cut, Copy, Paste, Delete.

e. Button 12: Undo. Keyboard shortcut is ALT + BACKSPACE.† 

f.  Button 13: Redo. 

*. The active window is said to have “focus.”

†. Windows Undo keyboard shortcut, CTRL + Z is not enabled.
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Several layers of Undo and Redo are available. As in other Windows applications,
once the record is saved, previous Undo’s and Redo’s are lost. (The button will be
greyed out when the option is not available.)

g. Button 14: Properties. All objects on the form have properties. This 
button opens the Object Properties dialog. In most cases, we will use 
the Properties Pane rather than this dialog, because it is more conve-
nient. This button also has Right Click Menu and Hot Key options 
[F12].

h. Button 15: Events that have been designed for the form or object can 
be viewed here. Window launches the Script Editor for Action Script-

ing* or Xbasic. (Also has Right Click Menu and Hot Key options 
[F11].) 

•You can also DOUBLE CLICK on an object to open its Events.

The Properties and Events buttons are Context Sensitive. When the Form
has focus, Form Properties are displayed. When a different object has focus, its proper-
ties come up. The same is true for Events.

• The following buttons toggle between Show and No Show. (Orange color means 
they are showing.)

i. Button 16: Rulers.

j. Button 17: Toolbox. Contains form design tools.

k. Button 18: DragDrop List. Contains available fields for easy place-
ment on form.

•Rulers, Toolbox and DragDrop List have several display options (see “Using 
the Task Panes” on page 91).

The following can also be turned on and off depending on the task at hand. We will
illustrate their use in the exercises that follow.

l. Button 19: Text Toolbar.

m. Button 20: Border Toolbar.

n. Button 21: Arrange Toolbar.

o. Button 22: Copy Format Toolbar.

p.  Button 23: Anchor Toolbar (aka Stretch Toolbar).

q. Buttons 24, 25: Group and Ungroup. Become active when two or 
more fields are selected. Also available on the Arrange Toolbar.

• These buttons open lists for editing purposes.

r. Buttons 26, 27: Display the Calculated Fields and Variables that 
have been designed for this form. See “Creating Calculated Fields” on 
page 155 and “Understanding Variables” on page 326. 

•These buttons work only after Calculated Fields and/or Variables 
have been designed for the form.

s. Button 28: Alpha Five Control Panel: This button functions the 
same as the Control Panel tab at the bottom left of the screen. It is 

*. We will use Action Scripting in Chapter 7.


